
The Summons 

Special points of interest: 

Oregon Cell Phone Laws 

Create a Family Disaster Plan 

Getting to know your Office 

Can You Pass the ALS? 

 The next regular monthly 
meeting of NALS of Southern Or-
egon Coast will be held on Tues-
day, September 18, 2012, at 5:30 
p.m.   
 
 As always, continuing le-
gal education will be provided 
free of cost to members of the 
legal community. 
 
 All persons interested in the 
legal field are invited to attend.  
Please call Tracy Hoye at (541) 

NALS of Southern Oregon Coast...the association for legal professionals 
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NALS of Southern Oregon Coast  
Annual Picnic……….Yyuuummmmm! 

 

267-3781 to order  your dinner se-
lection. 
 

The meeting location will be at: 
 

Ciccarellis 
2076 Sherman Avenue 
 in North Bend, Oregon  

 

 

 The NALS of Southern Ore-
gon Coast Annual Picnic is set for 
August 21, 2012 this year.  The 
picnic will be at the home of NALS 
of Southern Oregon Coast Presi-
dent, Mary McNamee in North 
Bend.  This year’s food theme is a 
Taco Bar!!!   Yum.   

In addition, NALS of Southern Ore-

gon Coast members have invited 

their two scholarship award recipi-

ents to join in the fun  and meet all 

of the members. 

 

 

  



Hello Members  
 
Well, here we are already in August.  It 
seems like the whole summer is flying by.  I 
hope you have all had time to do fun stuff. 
 
At the Board meeting it was decided that 
our annual Picnic/BBQ will he held at my 
home in North Bend.  It is going to prove to 
be interesting because my home is not that 
large, but it is homey.   
 
I have noticed that this year, we haven’t had 
very many days with sunshine.  It’s either 
been overcast or very windy.  However, as 
many of you know, our best months are 
August, September, and October. 
 
I have tentatively scheduled myself to go on 
a road trip with a very dear friend of mine.  
He is planning a trip to Connecticut, Penn-
sylvania, and beyond.  I haven’t had an op-
portunity to travel for the last 16 years, so I 
am taking this opportunity to do so.  I plan 
to take off approximately one month from 
work.  I’ll give everyone an update as my 
plans progress. 
 
I am hoping to see everyone at our annual 
Picnic/BBQ.  We will have a taco bar for the 
first time. I know everyone will enjoy them-
selves.   
 
The yearly picnic might also be the perfect 

opportunity to include  a friend in the legal 
field who could become a potential new 
member.  That way they could meet the 
membership and have a chance to get to 
know everyone. 
 
Our regular educational meetings will start 
again in September with great education.  I 
also want to remind everyone that October 
is Court Observance month. 
 
Until then, enjoy the summer and I will  see 
everyone at the annual picnic at my home. 
 
Mary McNamee, PLS 
President    
 

 
 
 

PRESIDENT’S MESSAGE 
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NALS of Southern  

Oregon Coast 

2012-2013 Board Members 
 

President 

Mary McNamee PLS 

3837 Sherman Avenue 

North Bend, OR 97459 

Phone: (541) 404-5736 

Email: marym@coastalcenter.net 

 

Vice President 

Diane Whitson PLS 

1895 Maple Street 

North Bend, OR 97459 

Phone:  (541) 756-7181  

Email:  blu2you@frontier.com  

 

Secretary 

Mindy Woodworth PLS 

P.O. Box 1006 

North Bend, OR 97459 

Phone: (541)  756-2066 
Email:mindy@stebbinsandvoffey.com   

  
Treasurer 

Kelli Burnette  

P.O. Box  1178 

Coos Bay, OR 97420 

Phone:  (541) 269-1123 

Email:  kelli@epuerto.com  

 

Director 

Raquel Wood PLS 

P.O. Box  1178 

Coos Bay, OR 97420 

Phone:  (541) 269-1123 

Email: rwood@epuerto.com  

Summons Editor 

Diane Whitson, PLS 

1895 Maple St. 

North Bend,  OR 97459 

Phone:  (541) 297-6682 (c) 

Email: blu2you@frontier.com 

Summons Distributor 

Roberta Granby, PLS 

3035 Leaf Terrace 

Coos Bay, OR 97420 

Phone: 269-9219  

Email: 

rjgranby@frontier.com 

 The NALS 2012 National Forum & Education Conference will be held October 
18-21 in Portland, Oregon at the Sheraton Portland Airport Hotel, 8235 Northeast Airport 
Way, Portland, Oregon 97220.   
 
 Be sure to reserve your space by calling  503-249-7606.  We currently have a rate 
of:  $119 single/double.  URGENT –MAKE YOUR RESERVATIONS NOW!!  The  first 
room block is FULL and the hotel is making extra rooms available for a short time. 

NALS NATIONAL EDUCATION  
CONFERENCE  PORTLAND OREGON  

OCTOBER 18-21, 2012! 

DO YOU HAVE A FRIEND OR CO-WORKER  

THAT WANTS TO BE A MEMBER? 
 
FOLLOW THE LINK FOR A MEMBERSHIP APPLICATION FORM.  BE SURE TO SIGN IT 
AS A SPONSOR AND WIN POINTS IN MEMBERSHIP CHALLENGES.   www.nals.org/
download/membershipapp.pdf 

mailto:blu2you@frontier.com
mailto:mindy@stebbinsandvoffey.com
mailto:kelli@epuerto.com
mailto:rwood@epuerto.com
mailto:blu2you@frontier.com
mailto:robertagranby@verizon.net
http://www.nals.org/download/membershipapp.pdf
http://www.nals.org/download/membershipapp.pdf
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EDITOR’S CORNER 

Greetings Everyone: 
 
This month’s Summons features two pertinent 
articles for today.  The first is an article on Ore-
gon law regarding texting and cell phone use.  
The second is how to create a family disaster 
plan since there has been much talk of Tsunamis 
in our area. 
 
Also, once again, Dee Crocker from the PLF  has 
provided many “tips” for the month.  Thank you, 
Dee!  We do appreciate it. 
 
Have you been taking the quizzes in every issue?  
How are you doing?  These all come from the 
NALS legal training Course or the ALS and PLS 
exams.  So, practice makes perfect and you can 
receive your certification in the future.  Watch the 
Summons for testing dates or go online at 
NALS.org for more info.  
 
Remember to check out the yearly calendar.  It 
notes all of the monthly meeting days for NALS of 
Southern Oregon Coast.   
 
Finally, this is your publication and your submis-
sions are always welcome. 
 
   
Diane Whitson PLS 
Editor, The Summons  

   

2012 NALS of Oregon Fall Board—September 20-23—Holiday 

Inn, Eugene/Springfield ,OR 

 

 

 

 

 

 

 

NALS INC.  National Seminar—Portland, OR—October 17-20, 

2012 

 

NALS of Oregon  Winter Board—TBA 

 

2013 NALS of Oregon Spring Board Meeting  April 26–28, 2013 

at Mt. Bachelor Village Resort in Bend  
 

Mark your calendars and be sure to attend these GREAT meetings! 

Raquel Wood July 15 

Maxene Grabe August 4 

Diane Whitson August 30 



Take A Break 
 
BreakTaker is a lightweight application for Win-
dows that reminds you to take breaks while 
working on your computer. http:/ /
www.techerator.com/software/breaktaker/  
 
By encouraging you to take short breaks at reg-
ular intervals, BreakTaker can increase your 
overall productivity and can alleviate common 
workplace injuries resulting from fatigue, eye 
strain, and repetitive stress injury. After launch-
ing BreakTaker, right click its icon to change the 
time between break notifications. The default 
notification delay is 55 minutes. 

Check for Notary training in your area 
 

Brush up your notary knowledge and get the 
answers to your questions by attending a semi-
nar for current and future notaries public. The 
seminars are a comprehensive and thorough 
examination of notary basics: what a notary is, 
responsibilities and liabilities, how to notarize, 
notary certificates, and the notary journal. 
What's more, this is your chance to talk to the 
state agency that regulates notaries, and partic-
ipate in lively discussions about procedures, 
practices and notary laws. 
 
Visit their website for further information on no-
tary seminars throughout  Oregon:  http://
notsem.sos.state.or.us/  

Free Speech to Text Conversion 
in Your Browser 

 
If you have never tried using automatic dictation software, 
then here's an easy way to do  so.  Use your web browser 
to visit www.talktyper.com  and you're ready to start speak-
ing. 
 
You'll need a supported browser (Chrome is recommend-
ed), and you'll also need a microphone  on your PC of 
course.  Then just start speaking, one sentence at a time.  
Your spoken text appears in the top half of the window, 
ready for you to edit if required, and then to copy down  
to the main document in the lower half of the window.  
Once you've assembled an entire document or letter, you 
can print, email, or copy it to the clipboard for subsequent 
use. 
 
Talktyper isn't the best dictation software I've ever used.  
And because it sends your speech to a  remote server in 
order to decipher, it's probably not the most secure either.  
But it's quick,  simple, free, and a great way to try out the 
technology if you've never used such a thing  before.  And 
it'll keep the kids entertained for hours too. 
 
The Practice Tip of the Week is a service of the Professional Liability 
Fund.  The tips are not  meant as legal advice, nor binding on any bar 
association. For  additional information about  PMA services in Oregon, 
contact Dee Crocker, Sheila Blackford, or Beverly Michaelis at the PLF:  
(503) 639-6911, (800) 452-1639, or www.osbplf.org  



Be Selective with How You Select 

You already know that double-clicking selects a single word, 

and you probably figured out that triple-clicking selects an 

entire paragraph. But if you just want to select a single sen-

tence, hold down Ctrl and click on any word. To select an 

entire table, hold down Alt and double-click. 

 

Add a Comment Box 

When a friend or family member sends you a document to 

proofread, don't waste your time writing a lengthy email de-

tailing all the horrendous mistakes you found; mark up their 

Word file instead. Highlight a portion of text, click the Re-

view tab in the Ribbon bar, and select New Comment. 

 

Insert Bullets and Number Lists Using Your Keyboard 

When inspiration hits, lifting your fingers off the keyboard to 

use your mouse can mess up your mojo, but what do you do if 

you need to insert a bullet or numbered list? It's simple: type 

an asterisk and hit the spacebar to auto-create a bullet list. 

You can do the same with numbers and dashes. 

 

Use the Built-In Thesaurus 

You don't need to hop online to use a thesaurus, the folks in 

Redmond had the good sense to bundle one in Word. To use 

it, highlight an entry and press Shift+F7. Pretty simple, right? 

Or maybe we should say it's trouble-free, straightforward, 

effortless, uncomplicated, or painless. 

 

Backup/Transfer Your Settings 

Nearly every customization you make to Word gets saved in 

the Normal.dot template, a hidden file that you should keep 

backed up. You'll find it by navigating to 

C:\Users\[username]

\AppData\Roaming\Microsoft\Templates. Be sure to enable 

viewing of hidden files, folders, and drives. 

 

Extend Word's Trial Period 

Microsoft allows you to test drive Office 2010 free for 30 

days; after that, you have to pony up for a license and acti-

vate. Or you can ‘rearm' Office for another 30-day trial, up to 

5 times for a total of 180 days. To rearm, open an elevated 

command prompt and go to C:\Program Files\Common 

Files\Microsoft Shared\OfficeSoftwareProtectionPlatform and 

run OSPPREARM.exe. If you installed the 32-bit edition of 

Office on a 64-bit OS, replace Program Files with Program 

Files (x86). 

 

Insert Screenshots into Word 

One of our favorite new features in Word 2010 is the ability 

to glue screen grabs right into the document we're working 

on. Just use the Print Screen key as normal to grab an image, 

and then go to Insert > Illustrations > Screenshot. 

 

Hop Back and Forth with Bookmarks 

To add a bookmark in Word, position your cursor and go to 

Insert > Links > Bookmark. Give your bookmark a name and 

More Practice Tips from PLF 
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click Add. To jump back to that point, just go back to the Book-

mark menu, highlight your entry, and click Go To. 

 

Select Text Vertically 

Did you mess up your numbered list? Maybe some funky sym-

bols got placed at the beginning of each sentence when you cop-

ied over an email. Whatever your reason for wanting to select 

text vertically, you can do so by holding down the Alt key and 

using your mouse cursor. 

 

Password Protect Work Documents 

One of these days, you're going to punch your obnoxious room-

mate square in the face for digging around your personal docu-

ments. Or better yet, just lock your docs. To password protect a 

Word document, click on File > Info > Protect Document > En-

crypt with Password. 

 
The Practice Tip of the Week is a service of the Professional Liability Fund.  The 

tips are not meant as legal advice, nor binding on any bar association. 

For  additional information about PMA services in Oregon, contact Dee Crock-
er, Sheila Blackford, or Beverly Michaelis at the PLF: (503) 639-6911, (800) 

452-1639, or www.osbplf.org.    

http://www.osbplf.org
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Oregon Driving Laws Regarding Texting and Cell Phones 

Oregon prohibits texting and use of handheld cell phones 
for all drivers with the exception of police, emergency re-
sponders and drivers in emergency situations. Novice driv-
ers are prohibited from all cell phone use.  
 
Specifically, Oregon law bans the use of a “mobile commu-
nication device” while driving. This device is defined as a 
text messaging device or a wireless, two-way communica-
tion device designed to receive and transmit voice or text 
communication. Exceptions include:  

summoning medical or other emergency help if no other 

person in the vehicle is capable of summoning help;  

using a mobile communication device for the purpose of 

farming or agricultural operations;  

operating an ambulance or emergency vehicle;  

if a person is 18 years of age or older and is using a 

hands-free accessory (a device that when used al-

lows the driver to maintain both hands on the steer-

ing wheel);  

operating a motor vehicle while providing public safety 

services or emergency services as a volunteer;  

operating a motor vehicle while acting in the scope of the 

person’s employment as a public safety officer, as 

defined in ORS 348.270; or 

operating a motor vehicle in the scope of the person’s 

employment if operation of the motor vehicle is nec-

essary for the person’s job;  

Cell Phone Use 
 
All drivers are prohibited from using handheld cell phones 
(see above). Drivers under the age of 18 are prohibited 
from using cell phones, texting devices and other hand-
held or hands-free wireless electronic devices. 
If handheld cell phones are prohibited, then what’s permis-
sible? Here are the common options: 

Abstinence (don't use a cell phone while driving) 

Speaker Phone 

Use a bluetooth wireless device 

Use a wired headset 

Install a car kit 

Texting 
 
All drivers are prohibited from texting while driving.  

Bus Drivers 
 
Bus drivers are prohibited from using handheld cell 
phones and from texting. 
 
How is it Enforced?  
 
The fine for violating Oregon’s cell phone or texting laws 
is $142. Oregon’s cell phone and texting laws are consid-
ered “primary” laws. A primary law means that an officer 
can pull you over for the offense without having to witness 
some other violation. That is, the officer sees you texting 
and issues a citation.  Learn more about Oregon’s dis-
tracted driving laws. 
 

http://www.drivinglaws.org 
Copyright © 2012 ExpertHub.com. All rights reserved. 

Submitted by Connie Prince 

http://www.oregon.gov/ODOT/TS/docs/publications/HandsFree_External_Jan2010.pdf?ga=t
http://www.oregon.gov/ODOT/TS/docs/publications/HandsFree_External_Jan2010.pdf?ga=t
http://www.drivinglaws.org


Page 7 The Summons 

 THAT……Bath salts, designer drugs, prescription drug abuse, the return of heroin — all bad, no 

doubt, and all the subject of recent headlines on rising illicit drug trends. But nothing touches alcohol abuse. 

The most legal of controlled substances is still the most destructive. 

 
 THAT…..Excessive drinking cost the U.S. economy $223.5 billion in 2006, according to the federal 

Centers for Disease Control and Prevention. In 2009, 10,839 people were killed in alcohol-impaired driving 

crashes, accounting for roughly one-third of all traffic-related deaths in the U.S. that year. 

 
 THAT....members Diane Whitson PLS and  Raquel Wood PLS have 

been sailing this summer (and camping on their boats).   Guest included Brenda 

Collette and Tracy Hoye PLS.   

 

 THAT….member Alysha Smith is vacationing in Reno. 

 

 THAT…..Member Ginger Foltz continues to take pride in her son, Chris 

Foltz’s, constant wins in carving competitions. 

 

 THAT….member Susan Thorton is enjoying her new job.  Ask her! 

  

Oregon 
Lawyer  
Referral  
Service 

 

Hours:  
M-F 8-12 p.m.  
and 1-5 p.m. 
Phone:   
503-684-3763 
Or toll-free in  
Oregon at  
1-800-452-7636 

 

 

LEGAL SUPPORT  

SERVICES, LLC 
P.O. Box 67 

Port Orford, OR 97465 

 

Perri L. Rask 
Fiduciary 

 

Providing private,  

professional  

fiduciary services  

throughout Oregon  

for over 15 years. 
 

P.O. Box 67   Phone: (541) 643-5955 

Port Orford, OR 97465  FAX:     (541) 332-0852 

 

 

Email: legalsupportservices@frontier.com 



How to Create a Family Disaster Plan 
Meet with your family. 

* Discuss the types of disasters that could occur   *Explain how to prepare and respond 

*Discuss what to do if advised to evacuate          *Discuss what to do with pets-Red Cross does not 

                                                             allow pets in their shelters 

*practice whatever you have discussed 

 

Plan how your family will stay in contact if separated by a disaster. 

Pick two meeting places: 

     1.  A location a safe distance from your home in case of fire 

     2.  A place outside your neighborhood in case you cannot return home 

*Choose an out of state friend or relative as a "check in contact" for everyone to call 

 

Complete these steps. 

 

*post emergency numbers by every phone 

* Show responsible family members how and when to shut off the water, gas and electricity at main switches 

*Install a smoke detector on every level of your home. Test monthly and change the batteries at least twice a year 

*Learn first aid and CPR 

*Meet with your neighbors and plan how you could work together after a disaster 

*Make plans for child care in case parents cannot get home 

*consider how you could help neighbors who have special needs, such as elderly or disabled persons 

 

Individual/Family Disaster Supply Kits 

 

WATER- A normally active person requires a minimum of 2 quarts of water per day. Hot environment or intensely stressful activi-

ties can double that amount. Nursing mothers, children and ill people will need more. Store at least 1 gallon of water per person per 

day in plastic bottles such as soft drink bottles. DO NOT use plastic milk cartons or glass containers that will break. 

 

FOOD- Store at least a 3 day supply of non-perishable food per person. A three day supply is absolute minimum. Food should re-

quire no refrigeration, preparation or cooking and little or no water. 

     If you need to heat food, pack a can of sterno. Food items should be compact and lightweight.  

     Suggestions include: 

     *Ready to eat canned meat, fruits and vegetables, canned juices, milk and soup; staples like sugar, salt & pepper 

     *High energy foods; peanut butter, jelly, crackers, granola bars, trail mix 

     * Vitamins 

     *Food for infants, elderly persons, or those on special diets, if appropriate 

     *Comfort stress food; cookies, hard candy, sweetened cereals, lollipops, instant coffee, tea bags 

     * Prepackaged foods such as MREs 

     *Non-electric can opener 

     *Keep a 72 hour emergency preparedness kit in your car 

     *Keep a 72 hour emergency preparedness kit in your home 

     * Consider keeping a kit near your desk at work 

 

FIRST AID KIT-You should assemble a first aid kit for your home, for each individual 72 hour disaster preparedness kit and for 

each vehicle. These can be put together at home or purchased.  Learn how to use the items in your kit.  The more you know, the 

better prepared you will be to treat an injured family member or yourself. 

 

TOOLS and SUPPLIES-Flashlight and extra batteries, battery operated radio and extra batteries, shut off wrench for household 

gas and water, pliers, sanitation and personal hygiene supplies, small sewing kit, fire extinguisher, whistle, paper and pencil. Con-

sider standardizing all battery powered items in your kit to use the same batteries, such as AA batteries. Also consider LED lights. 

They are bright, can be inexpensive and prolong the life of your batteries. 

 

CLOTHING and BEDDING-Include at least one complete change of clothing and footwear per person, sturdy shoes or work 

boots, rain gear/thermal underwear, blankets and/or sleeping bag,  hat and gloves, sunglasses. 

 

PERSONAL VEHICLE-Gas tank full, tool box (which includes tow cable and jumper cables), extra oil  and anti-freeze, emergen-

cy flares and distress flag/signal, flashlight and extra batteries, portable radio with extra batteries, traction devices, bag of sand and 

shovel, windshield scraper and brush, first aid kit with necessary prescriptions, blanket or sleeping bag, bottled water, canned fruit/

nuts and non-electric can opener. 



SPECIAL ITEMS: Remember family members with special needs such as infants and elderly or disabled persons. Pack their kits 

accordingly. Include diapers and formula, or prescription medications. Keep important documents in a waterproof container. These 

documents might include insurance policies, contracts, deeds, stocks and bonds, wills, passports, social security  cards, immuniza-

tion records, bank account and credit card numbers, company contracts, an inventory of household goods, birth, marriage and death 

certificates, important telephone  numbers, and copies of prescriptions. Have traveler's checks, cash and change on hand. Extra 

medication, spare eyeglasses and anything else you think you might need. 

 

This is your personal preparedness kit. Customize it to meet your individual needs. Don't forget to plan for your pets, too! Supplies 

for 72 hours should be considered a bare minimum. In your home, you should be prepared to survive for far longer than 72 hours. 

This would be adequate for a local storm event, landslide that isolates the local area for a couple of days. In the event of a large 

earthquake and tsunami in your area, you may be isolated for a couple of weeks, or more. Emergency services will be stretched 

very thin in these events and may even be incapacitated by the event. Don't count on someone else to take care of you. 

Review kit contents every three to six months and update as needed. Rotate water, food, and medical supplies. Update important 

papers and emergency contact numbers. 

Submitted by Diane Whitson PLS 



GETTING TO KNOW YOUR OFFICE 
 

Firm Name:  Whitty, McDaniel, Bodkin & Combs, LLP 

 

   

Attorneys in the firm or office:  John Whitty, William A. McDaniel, Michael N. 

Bodkin and Andrew E. Combs 

 

Type of law practice/Specialties: estate planning, trust administration, probate, commercial foreclosures, 

real property, contracts, civil litigation, business law  

 

 

Contact information:  444 North 4th Street 

     P.O. Box 1120 

     Coos Bay, Oregon 97420 

     Phone:  541-267-2156 

     Fax:  541-269-0839 

 

 

Other Staff and positions:  Four legal assistants, a bookkeeper and a part-time receptionist 

   

Something special about your firm or office or attorneys?  Our law firm has represented businesses and 

individuals on Oregon’s South Coast since 1880.  We specialize in estate planning, business and real property 

law.  Bill McDaniel and Andy Combs also handle civil litigation, including personal injury law, elder abuse 

and will contests. 

WANT TO ADVERTISE IN 

THE SUMMONS? 
Yearly Rates: 

Business Card:  $25    

  Quarter Page: $50 

Half page: $80     

  Whole page: $100 
 

Ad copy can be submitted via email to: 

blu2you@frontier.com  or  dwhitson@ctclusi.org   

  

Send checks payable to: NALS of Southern Oregon Coast 

Kelli Burnette 

P.O. Box  1178 

Coos Bay, OR 97420 

 

 

A politician needs the ability 

to foretell what is going to 

happen tomorrow, next week, 

next month, and next year, 

and to have the ability after-

wards to explain why it didn't 

happen.  
Winston Churchill  

Want us to know YOUR OFFICE?   

Contact the Summons editor at 

 dwhitson@frontier.com  

with your information.   

It helps other legal staff  

to be able to direct  

potential clients to the 

 appropriate office.    

WANTED.  would like to have someone SHARE MY HOME while I'm gone for 6 months at a time.  I'm hoping one of you may 

know of someone you could recommend; someone trustworthy who might be interested in my extra room/bath; someone who is 

comfortable sharing the house with me the six months I'm here.  If so, let me know. 

  

Maxene Grabe—541-297-5427  

mailto:blu2you@frontier.com
mailto:dwhitson@ctclusi.org
http://www.brainyquote.com/quotes/quotes/w/winstonchu135267.html
mailto:dwhitson@frontier.com
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Action Trophies 

Bam Cam   

Bev’s Flowers   

Bonk & Bonk Investigations 

CAGA Certified Appraiser– Shelly Dubisar 

CC Reporting and Video Conferencing 

Emerald City Legal Support Service 

Knoll Reporting Service  

Legal Support Services 

Minuteman Press 

SSR Processing Service - Shelly Dubisar 

Tri-County Legal Support Services 
 

These advertisers  have been great supporters of NALS 
and NALS of Southern Oregon Coast.  When you use 
their services, please tell them you read about them in 
The NALS of Southern Oregon Coast SUMMONS. 

 

No-Knead Bread  

Time: About 1½ hours plus 14 to 20 hours’ rising 
3 cups all-purpose or bread flour, more for dusting 
¼ teaspoon instant yeast 
1¼ teaspoons salt 
Cornmeal or wheat bran as needed. 

1. In a large bowl combine flour, yeast and salt. Add 1 5/8 

cups water, and stir until blended; dough will be shaggy 

and sticky. Cover bowl with plastic wrap. Let dough rest 

at least 12 hours, preferably about 18, at warm room 

temperature, about 70 degrees.  

2. Dough is ready when its surface is dotted with bub-

bles. Lightly flour a work surface and place dough on it; 

sprinkle it with a little more flour and fold it over on itself 

once or twice. Cover loosely with plastic wrap and let rest 

about 15 minutes.  

3. Using just enough flour to keep dough from sticking to 

work surface or to your fingers, gently and quickly shape 

dough into a ball. Generously coat a cotton towel (not 

terry cloth) with flour, wheat bran or cornmeal; put dough 

seam side down on towel and dust with more flour, bran 

or cornmeal. Cover with another cotton towel and let rise 

for about 2 hours. When it is ready, dough will be more 

than double in size and will not readily spring back when 

poked with a finger. 

4. At least a half-hour before dough is ready, heat oven 

to 450 degrees. Put a 6- to 8-quart heavy covered pot 

(cast iron, enamel, Pyrex or ceramic) in oven as it heats. 

When dough is ready, carefully remove pot from oven. 

Slide your hand under towel and turn dough over into pot, 

seam side up; it may look like a mess, but that is O.K. 

Shake pan once or twice if dough is unevenly distributed; 

it will straighten out as it bakes. Cover with lid and bake 

30 minutes, then remove lid and bake another 15 to 30 

minutes, until loaf is beautifully browned. Cool on a rack. 

Please support our  

advertisers! 

Yield: One 1½-pound loaf.  

 

 

 

 

 

 

 

 

 

 

Submitted by Diane Whitson PLS and YES, I make this. 
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CAN YOU PASS THE ALS? 
1 
.  The authoritative guide to proper legal citation is _________ 
      a.    Black's Law Dictionary 
      b.    the "Bluebook"  
      c.    The Gregg Reference Manual 
 
2.    A pleading that is in good form but is presented in bad faith is a pleading. 
      a.    liberal construction 
      b.    frivolous 
      c.    sham  
 
3.    A defense that is presented to defeat a cause of action is a  ___________defense. 
      a.    dilatory 
      b.    general 
      c.    peremptory  
 
4.    When joining citations in a sentence, separate each citation by the use of a 
      a.    comma 
      b.    period 
      c.    semicolon 
 
5.    A complete case citation (in correct order) contains the name of the case first, followed by the ____________ 
      a.    volume number of source, abbreviated name of volume, and beginning and ending page numbers of the case 
cited                         
      b.    volume number of source, abbreviated name of volume, page upon which the citation begins, and parenthetical 
information that  identifies the court and date of the decision  
      c.    volume number of source, full name of volume, page upon which the citation begins, and parenthetical infor-
mation that identifies the court and date of the decision 
 
6.     The proper citation of a case in which a state sues on behalf of an individual is 
       a.    State a ret Doe v. Smith 
       b.    State in re Doe v. Smith 
       c.    State v. Smith 
 
7.     The correct citation to the United States Constitution is 
       a.    U.S. Const. Art. II, § 4 
        b.   U.S. Const. art. II, § 4 
        c.   U.S. Const., art. II, § 4 
 
8.     ____________ are always placed inside quotation marks. 
       a.    colons and semicolons 
       b.    question marks 
       c.    periods and commas  
 
9.     Generally, you should indent quotations that are more than __________words. 
       a.    25 
       b.    50  
       c.    100 
 
10.   The correct citation to Federal Reporter, Second Series is 
       a.    FR. 2nd 
       b.    F.2d  
       c.    Fed. 2d 

 

 
 
           Answers on page 18 
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COMMITTEES 2012-2013 
MEMBERSHIP CHAIR 

Diane Whitson, PLS 

1895 Maple Street 

North Bend, OR 97459 

Phone: 541-756-7181  

Email: 

dwhitson@ctclusi.org 

 

We’re on the Web!    www.nals.org 

NALS, Inc.® is dedicated to enhancing the competencies and contributions of members in the legal services profes-

sion. It accomplishes its mission and supports the public interest through: 
 

Continuing legal education and resource materials; 

Networking opportunities at the local, state, regional, and national levels; 

Commitment to a Code of Ethics and professional standards; and 

Professional certification programs and designations. 
 
There are local chapters throughout the state of Oregon and members are typically career legal support staff who are 
interested in learning as much as possible about the legal profession and keeping up to date on changes in the law. 
 
Our membership is open to any persons employed in work of a legal nature, including legal secretaries, legal assistants, 
paralegals, court personnel, law librarians, law office administrators, and even attorneys and judges. We are a nonparti-
san, nonunion, nonprofit organization whose main objective is to further the education and training of legal support staff 
to enhance the competencies of members in the legal services profession. 

ANSWERS TO ALS MOCK 

EXAM 
 

1. B  6 A 

2. C  7. B 

3. C  8. C 

4. C  9. B 

5.  B  10. B 

 

Membership and Annual/Fall Boards Reim-

bursement Funds notices                                   

Diane Whitson, PLS 

  

Bar Liaison: 

  

Reservations: 

Tracy Hoye 

  

Bosses Event:  

 Kelli Burnette 

  

Ways and Means (Fundraising): 

Diane Whitson PLS 

 

Webmaster: 

Diane Whitson PLS 

 

Nominations: 

                  Tracy Hoye, PLS 

  Kelli Burnette 

 

Financial Review: 

                 Mindy Woodworth PLS 

                  
   

Budget: 

Roberta Granby PLS 

Diane Whitson PLS 

 
  

Program Education and Press Releases: 

Including Day in Court (October) 

 

 

  

Scholarships (Member and Student): 

Raquel Wood ALS 
                  Mindy Woodworth PLS 

Summons: 

Diane Whitson PLS 
Mindy Woodworth PLS 

Roberta Granby PLS 

Connie Prince 
 

Historian: 

 

 

Recruiting Committee Volunteers! 

 

Contact NALS of Southern Oregon 

Coast President Mary McNamee to let 

her know where you want to volun-

teer. 

mailto:robertagranby@verizon.net
http://www.nalsor.org/membership.htm





